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1 — INTRODUCTION

Thank you for purchasing your Link ElectroSystems Ltd. Plug-In
Engine Control Unit (ECU). Link G3 ECU's are an advanced, fully
programmable microprocessor controlled Engine Management System.
The EVOLink® is the third generation of the successful range of
EVOLink ECU's now based on the new G3 software/hardware
platform.

All Link Plug-In Engine Management Systems are designed with
minimum installation in mind. Where practical, Link Plug-In systems
replace the circuit board inside the factory ECU enclosure. This
provides an unobtrusive means of fitting a fully programmable engine
management system to your vehicle without any permanent
modifications and a completely invisible install.

Link Engine Management Systems are designed with the final result in
mind. Not only do they boast an impressive range of performance
features, but are designed with a focus on safety, reliability and drive-
ability. However, the ultimate success of your engine management
upgrade is determined by how well the system is installed and tuned.

LINK G3 ECU'S

G3 ECU's are the third generation of Link ElectroSystems proven
Engine Management Systems. What makes G3 ECU's unique is a new
hardware design based around one of the most powerful
microprocessors used in after-market engine management. Hardware is
designed using the latest technologies for ultimate performance,
reliability and electromagnetic interference compliance.
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A new software architecture has also been developed to optimise the
potential of this processor. This G3 software platform boasts an
impressive list of features giving new levels of user adjustments. This
flexibility allows the tuner to have complete control over the engine
management system.

G3 software employs high resolution fuel and ignition tables with
configurable load and RPM centers. When coupled with four
dimensional fuel and ignition mapping, barometric pressure
compensation and intake air temperature correction this gives an
unprecedented level of tuning accuracy.

Included in the G3's impressive feature set are full variable valve
timing (VVT) control and advanced motorsport features. All G3 ECU's
are in field upgradeable, there is no need to return the unit for software
updates as new features are released.

LINK SUPPORT

Link ElectroSystems Ltd. appreciates your custom and has full
confidence that you will be satisfied with your engine management
system upgrade. Should any issue arise or for technical assistance the
following support options are available:
« Contact your nearest Link Dealer (a dealer list is available on our
website).
+ Link ElectroSystems Website — www.linkecu.com

« Technical Support Email — tech@linkecu.com
« On line Discussion — www.linkecu.com/forums
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2 - SAFETY FIRST

Your Link Plug-In ECU is designed to enhance the performance of
your vehicle. However in all cases, your vehicle must be operated in a
safe manner. Do not tune your vehicle while operating it on public
roads. Obey road rules at all times.

Failure to follow all installation and operating
instructions may result in damage to the Link ECU,
U

personal injury, or harm to property.
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3 - INSTALLATION

The following sections describe physical installation of the EVOLink®
ECU and required sensors. It is recommended that your Link ECU is
installed and tuned by a professional. This will ensure you get the most
out of your Link ECU minimise the possibility of damage to the ECU
or vehicle. The EVOLink® is sophisticated high end ECU and
requires significant knowledge of engine management to install and
tune.

3.1 - ECU INSTALLATION

For the EVO I to III the EVOLink® is designed to be installed in
place of the printed circuit board in the factory ECU (these ECU's are
in a metal enclosure). This creates a completely invisible install and
eliminates the need to modify ECU mounting points. For EVO IV to
VIII (ECU's in a plastic enclosure), the EVOLink® is supplied in its
own case that must be mounted in place of the factory ECU. For EVO
IX the EVOLink® is also supplied in its own case but also includes an
AdaptaLink to allow the ECU to be connected to the car.

WARNING

The following installation process will require handling of both
the Link ECU and factory ECU. Both of these are highly
sensitive to electrostatic discharge and are easily damaged.
Follow the anti-static precautions given in this manual carefully
to avoid damaging electronic components. Warranty claims for
ECU’s damaged by electrostatic discharge will NOT be
accepted.
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ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This
charge can reach very high voltages. = Whenever given the
opportunity this energy will attempt to discharge (usually through
your finger tips!). This can be fatal to most electronic components.
Most people have experienced an electrostatic discharge when they
step out of their car or touch a metal bench top.

The following guidelines describe precautions that can be taken to
reduce the possibility of damaging your ECU:

1. Work only on a conductive surface. A clean steel bench is
suitable.

2. Always wear a wrist strap that is electrically connected to the
conductive working surface.

3. Touch the working surface regularly.
4. Do NOT touch components on the circuit board.
5. Where possible, only handle the ECU by its plastic header.

6. Do NOT carry the ECU around without static packaging (the
black box supplied with the Link ECU is static protective).

7. Do NOT touch the bare terminals in the ECU header.
Observing the above procedures will minimise the chance of

damaging both the factory and Link ECU's. Note that failure due to
static damage often does not appear until well after it was caused.
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3.2 - PRE INSTALLATION CONFIGURATION

The EVOLink® covers a large range of models. Over the years

minor changes have been made to the factory ECU pin-out.

To

ensure the EVOLInk® is “wired” correctly for your vehicle
configuration jumpers must be installed in the correct locations. The
ECU is configured by installing the configuration jumpers as shown

below:

Model 12 I3
EVO 1 FIT REMOVE
EVO 1l
EVO III
EVOIV | REMOVE FIT
EVOV
s, [
EVO VII
REMOVE | REMOVE
EVO VIII
EVO IX

EVOLink G3 Inst. Manual
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3.3 — INSTALLATION - (EVO I - I1I)

Note: EVO's I to IIl use a three plug ECU. The
EVOLink® has four plugs. Connect the three factory
plugs to the appropriate ECU connector. The smallest
plug in the EVOLink® will be left unconnected.

Remove the factory ECU from the vehicle: Ensure the key is in the
OFF position. The factory ECU is located on the left side A pillar.
Remove the left kick panel. Unplug the wiring harness from the
factory ECU (press the locking button on each connector while gently
pulling on it). Remove the 6mm bolts (10mm socket) that retain the
ECU and remove the ECU from the vehicle. DO NOT touch the
exposed pins in the factory ECU connector.

Remove the factory ECU's circuit board from its enclosure: Ensure you
are following the given anti-static guidelines and ARE WEARING A
CONDUCTIVE WRIST STRAP connected to the working surface.
Remove the top cover from the ECU enclosure by removing the for
retaining screws. Remove the circuit board by removing four corner
screws. Hold it only by the plastic header and place it aside.

Fit the Link Plug-In ECU: Remove the Link ECU from its packaging
and place it immediately in the ECU enclosure. Place the factory ECU
in the packaging your Link ECU came in for its protection. It may be
necessary to break of the six small tabs on the sides of the circuit board.

Modify the enclosure top cover. Widen the ECU header slot. Also
leave room to allow the ECU header USB tuning cable to exit the
enclosure. DO NOT roll up the USB tuning cable and tuck it inside the
enclosure (rather remove it completely if need be). Ensure that any slot
or hole cut in the top cover will not eventually cut into the USB tuning
cable.
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Fit the ECU back to the vehicle: Fit the ECU back into the vehicle in
the reverse order to which it was removed (remember only three of the
four plugs will be used.

Refer to the special instructions section of this manual to check for
additional installation instructions for your model.

Do not attempt to start the vehicle until ALL the setup procedures
in this manual have been completed.

3.4 — INSTALLATION - (EVO IV — VIII)

Remove the factory ECU from the vehicle: Ensure the key is in the
OFF position. The factory ECU is located behind the glove box.
Remove glove box. Unplug the wiring harness from the factory ECU
(press the locking button on each connector while gently pulling on it).
Remove the 6mm bolts (10mm socket) that retain the ECU and remove
the ECU from the vehicle. DO NOT touch the exposed pins in the
factory ECU connector.

Remove the metal ECU mounting bracket.

Mount the EVOLink® on the metal mounting bracket. In some cases it
may be necessary to modify the bracket to fit. Refit the metal
mounting bracket and EVOLink® ECU.

Connect the wiring harness to the ECU.

Refer to the special instructions section of this manual to check for
additional installation instructions for your model.

Do not attempt to start the vehicle until ALL the setup procedures
in this manual have been completed.
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3.5 - INSTALLATION (EVO IX)

Remove the factory ECU from the vehicle: Ensure the key is in the
OFF position. The factory ECU is located behind the glove box.
Remove glove box. Unplug the wiring harness from the factory ECU
(press the locking button on each connector while gently pulling on it).
Remove the 6mm bolts (10mm socket) that retain the ECU and remove
the ECU from the vehicle. DO NOT touch the exposed pins in the
factory ECU connector.

Connect the AdaptaLink to the vehicles wiring harness. Connect the
EVOLink® ECU to the AdaptaLink using the supplied short harness.

Mount the ECU and Adaptalink in a secure location behind the glove
box.

Refer to the special instructions section of this manual to check for
additional installation instructions for your model.

Do not attempt to start the vehicle until ALL the setup procedures
in this manual have been completed.
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4 — MAP SENSOR INSTALLATION

A Manifold Absolute Pressure (MAP) sensor is supplied and must be
connected both electrically and pneumatically. Since the EVOLink
does not use the air flow meter, the MAP power supply and signal
return use the air flow meters unused wiring. This avoids the need to
run extra wires into the engine bay.

Note: Some models of EVO IX have a MAP sensor factory fitted to
the intake manifold. This map sensor is suitable for use with the
EVOLink® therefore external MAP sensor installation is not required.

The MAP signal replaces the AFM signal to the ECU. The MAP
sensors signal wire is connected the the AFM's signal wire.

Mount the supplied MAP sensor in a convenient location, keeping the
pressure tube and wiring lengths as short as possible. Do not mount the
MAP sensor directly on the engine or in a location subject to high
vibration or heat levels (such as near the exhaust).

Using automotive rated vacuum hose, plumb the MAP sensors pressure
port to a source of vacuum/boost. This will normally be in the plenum
chamber region, after the throttle plate. Do not be tempted to 'T" into an
unknown vacuum line. Ideally the MAP sensor should be connected to
its own port in the plenum chamber. A “T” into the fuel pressure
regulator vacuum/pressure line is also suitable.

The MAP sensor will be wired to the original air flow meter wiring.
MAP sensor wires must be properly soldered and insulated. It is
recommended that the MAP wires are soldered to the air flow meter
wires approximately 30 mm behind the air flow meter connector. It is
not necessary to cut the wires, but rather strip back a 10 mm section of
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insulation. Figure 2.1 shows wiring connections:

—
©@loleleloo|e] ) O
i Green (Ground)
. Red/Blue (+5V)
. White (Signal)
g 77 7777 O

Looking into back (wire side) of the Air Flow Meter Connector

EVO Ito III

(QQQOTQQ) O

Green (Ground)
. Red/Blue (+5V)
White (Signal)

A O

Looking into back (wire side) of the Air Flow Meter Connector
EVO V and EVO IX

Figure 2.1 — MAP Sensor Wiring Connections

After wiring is completed, it is essential that the air flow meter
connector is tied back in a manner that makes it impossible for it to
be connected back to the air flow meter. Connecting both the MAP
Sensor and air flow meter could result in damage to the air flow
meter or MAP Sensor and will result in tuning problems that could
cause engine damage.
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5 — IAT SENSOR INSTALLATION

An Intake Air Temperature (IAT) sensor must be connected electrically
and installed in the intake system. Since the EVOLink does not use
the air flow meter, the IAT sensor uses the air flow meters unused
wiring. This avoids the need to run extra wires into the engine bay.

Note: Some models of EVO IX have an IAT sensor factory fitted to
the intake manifold. This map sensor is suitable for use with the
EVOLink® therefore external IAT sensor installation is not required.

The IAT signal replaces the AFM's IAT signal to the ECU. The
IAT sensors signal wire is connected the the AFM's IAT signal
wire.

The IAT Sensor must always be installed to take advantage of the
EVOLink's air temperature correction features. The best state of tune
can not be achieved without intake temperature correction.

Note: Installation of the IAT sensor will require modification to the
intake system pipes. A threaded boss must be welded into the intake
pipes. This requires correct equipment and should only be performed
by a professional installer.

Install the IAT sensor in the intake system between the throttle body
and intercooler outlet. The sensor should be installed as close as is
practical to the throttle body.

EVOLink G3 Inst. Manual © Link ElectroSystems Ltd 2006 Page 14



Il =

IAT Sensor

A A A A A

Looking into back (wire side) of the Air Flow Meter Connector
The IAT sensor will be wired to the original air flow meter wiring. IAT
sensor wires must be properly soldered and insulated. It is
recommended that the IAT wires are soldered to the air flow meter
wires approximately 30 mm behind the air flow meter connector. It is
not necessary to cut the wires, but rather strip back a 10 mm section of
insulation. Figure 2.2 shows wiring connections:
EVO I to III
—

@000 0|9]9)

. A {1l=

IAT Sensor

A A A A A A4

Looking into back (wire side) of the Air Flow Meter Connector

EVO V and EVO IX
Figure 2.2 — IAT Sensor Wiring Connections

After wiring is completed, it is essential that the air flow meter
connector is tied back in a manner that makes it impossible for it to be
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connected back to the air flow meter. Connecting both the IAT Sensor
and air flow meter could result in damage to the air flow meter and will
result in tuning problems that could cause engine damage.
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6 — FIRST TIME SETUP

Although Link ECU's come with base settings that allow the engine to
be started, ALL Link ECU's must be professionally tuned immediately
after installation. Failing to have the ECU correctly tuned for your
vehicle could result in engine damage or violation of emissions laws.

6.1 - CONNECTING TO PCLINK

PCLink 1s Link ElectroSystems Ltd. ECU tuning software. This
software must be installed on a Windows based laptop/notebook before
any adjustments or tuning can be performed. The latest version of
PCLink will be require to tune you Link ECU and is freely available for
download from:

Link G3 ECU's come with on board USB support. Installation of
PCLink installs the required USB driver software. You MUST do a
complete install of PCLink before connecting the ECU to the PC for
the first time.

After installing the latest version of PCLink (which installs the Link
USB drivers), the ECU can be connected to the PC. Connect the ECU
to the PC using the supplied USB cable as shown in Figure 3.1. Note
that the cables fitted with an orange O'ring are USB cables.

After connecting the ECU to the PC, run PCLink (an icon should have
been placed on your PC's desktop).

Under the 'Options' menu select the correct COM port for
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communications with the Link ECU. If the COM port number is
unknown, it may be necessary to test all available COM ports until the
correct one is found. Select 'OK' to close the 'Options' window.

USB Tuning Port

EENEREEN DD

N
N

i N
SRl
X —

XS Connector DisplayLink Connector

Figure 3.1 - EVOLink® Tuning Cable Connection

To connect to the Link ECU, turn on the ignition switch then click on
the L symbol (top center of screen). All settings should now be loaded
from the ECU and the Link logo in the top right corner of the screen
should be spinning to indicate communications are OK. If an error
occurs during connection, recheck all wiring connections and ensure
the correct COM port is selected.

If connection can not be established, contact one of the support options
given in Section 1 of this manual.

Help on tuning functions is available in the PCLink on line help
(Press F1, or right click on any item and select "Whats This?").
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6.2 - INITIAL ADJUSTMENTS

It is important that the procedures described in the following sections
are followed before the Link ECU is tuned.

BASE CONFIGURATION

All EVOLink G3 ECU's are shipped with base configuration settings.
Note that these are provided to reduce initial setup and tuning times.
They are NOT recommended tuning values. PCLink includes base
configurations for all EVO models. Download the appropriate base
configuration into your ECU with PCLink by connecting to the ECU
using PCLink as described in Section 3.1, then selecting 'Open' under
the 'File' menu. Select the appropriate .pcl file and then select 'Open'.
Downloading large configuration files can take up to a few minutes. Be
patient and acknowledge any messages PCLink shows.

MAP SENSOR CALIBRATION

The following procedure must be performed before tuning to ensure
that the MAP Sensor is correctly calibrated. This is done by calibrating
the MAP sensor to the ECU's internal Barometric Absolute Pressure
(BAP) sensor. The BAP sensor is calibrated before the ECU is
shipped. To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the
ECU using PCLink as described in Section 3.1.

2. Under the 'Options' menu, select 'MAP sensor calibration'.
3. Follow the on screen instructions.

4. Select the 'Analog Inputs' tab in the runtime values section of
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PCLink (lower part of the screen).

Compare the MAP and BAP values and ensure they have a
similar reading (within 1 kPa).

Perform a 'Store' by clicking on the S button (top center of
screen) and clicking OK.

TPS CALIBRATION

The Throttle Position Sensor (TPS) is used by the ECU to calculate
various engine management parameters. It is important that the ECU
knows when the throttle is open and closed (or part way in between).
The following procedure calibrates the ECU to match the TPS:

1.

Connect a laptop/notebook PC to the EVOLink G3 and connect
to the ECU using PCLink as described in Section 3.1.

Under the 'Options' menu, select "TPS calibration'.
Follow the on screen instructions.

Select the 'Analog Inputs' tab in the runtime values section of
PCLink (lower part of the screen).

Ensure the Throttle Position value reads 0% when the throttle is
closed and 100% when fully open.

Perform a 'Store' by clicking on the S button (top centre of
screen) and clicking OK.

IAT SENSOR SELECTION

EVOLink G3 Inst. Manual © Link ElectroSystems Ltd 2006 Page 20



Where a MAF meter (Air Flow Meter) is not being used, an Intake Air
Temperature (IAT) sensor (installed in Section 2) is used by the Link
ECU to calculate fueling corrections based on the engines intake air
temperature. It is important that the EVOLink G3 is calibrated to
match the sensor installed in the engine. This procedure is as simple as
selecting the correct sensor type as follows:

1.

Connect a laptop/notebook PC to the EVOLink G3 and connect
to the ECU using PCLink as described in Section 3.1.

Click on 'Analogue Channel' in the configuration tree (white
area in top left corner).

Click on '"ANTemp2' in the configuration tree.
Ensure '"Temp Channel #2' is set to 'Inlet Air Temperature'.
Select the correct "Temp Sensor Type'.

Select the 'Analog Inputs' tab in the runtime values section of
PCLink (lower part of the screen).

Ensure that IAT reads the correct temperature.

Perform a 'Store' by clicking on the S button (top centre of
screen) and clicking OK.
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7 —EVOLINK G3 EXCESS CONNECTOR

As most of the EVOLink's input and output pins are configurable, these
pins can be used to connect other devices simply by re-wiring them (eg
if air con is no longer fitted, the air con clutch output could be used to
drive a shift light).

To reduce the need for modification of the factory loom, some Link
Plug-In ECU's have a connector that allows expansion of the ECU's
input and output capabilities. The EVOLink's XS connector is located
on the circuit board as shown in Figure 3.1. This connector allows the
following additional inputs to be connected:

e 1 x Analog Voltage Input (AN1 Volt) — 0-5V for wide band
Lambda, pressure etc...

e 1 x Analog Temperature Input (AN4 Temp) — Input for
thermistor temperature sensor.

e 2 x Digital Inputs (DI7 and DI8) — Digital Inputs for switches or
speed sensors etc...

The EVOLIink's XS connector does not have any additional output pins
as these are all used by other functions.

As it is seldom used, the EVOLink® is not shipped with the XS
connector wiring loom. Contact your nearest Link dealer to purchase a
loom. Wiring instructions are included with the loom.

Note: Do NOT attempt to connect anything to the EVOLink XS
connector without using the purpose built wiring loom. Doing so
may result in permanent damage to your Link ECU.
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8 — KNOWN ISSUES

Since development of the EVOLink G3 ECU, the following issues have
been discovered:

8.1 -EVO VIII JDM

1. EVO 8 models fitted with an immobiliser swap the functions of
ECU header pins 8 and 22 (Fuel Pump Relay and A/C Clutch).
For configure as follows:

Immobiliser No Immobiliser

Aux Inj 7 — A/C Clutch Aux Inj 7 — Fuel Pump

Aux Ign 3 — Fuel Pump Aux Ign 3 — A/C Clutch

2. Some EVO 8 models have sensor ground wired to pin 40. This
must be wired to pin 92 to ensure good grounding of all sensors.
This problem will present as incorrect reading of sensors and no
trigger inputs.

Lookmg into ECU Heaﬁder

112]3|4|5]6|7|8|9]10[11]12]13| |31|32|33|34|35|36|37|38| |51|52|53|54|55|56| |71|72|73|74|75|76|77|78|79/80|81
14/15]16|17]18|19|20|21|22|23|24|25|26| |39|40|41|42|43|44|45|46| |57|58|59|60|61|62| |82|83|84|85|86|87|88|89/90|91|92

\—/
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8.2-EVOIX

Some EVO IX models have been found to have incorrect fuel pump
speed control polarity. If the polarity is wrong the fuel pump speed
could be slow at full power causing lean running. You must perform
diagnostic tests to determine if this condition exists otherwise engine

damage could occur.

If fuel pump speed control is found to be

incorrect, correct this problem in PCLink by changing the 'Polarity’
setting in the Aux — Ignition 8 setup.

8.3-EVOIII

Some EVO III models have an additional wire fitted in the
ECU header that must be removed at installation. If this wire is
not removed the symptom will be that the wastegate solenoid is
energised all the time. This is a dangerous situation as boost
will be allowed to reach its maximum value therefore this
wire must be cut or removed. The following diagram shows
where to find the offending wire (pin 11 — Viewed looking into

the ECU's main header).

-—

1234567 & 910111213
L - - T -0 N F §
14 15 16 17 18 19 20 21 22 23 24 25 26
————— - -

31 32 33 34 35 36 37 38 || 51 52 53 54 55 56 || 71 72
- | - -
39 40 41 42 43 44 A5 46 |} 57 58 59 60 61 62|82 83
e | |-

BRE
21
Iz I3
I3 18
I3
Iz 13
I8 12
1213
I8 1=
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APPENDIX A — DEFAULT CONFIGURATION

The following table is a summary of the EVOLinkG3 input/output
default configuration:

EVO |, EVO Il, EVO Il
Auxiliary Drivers
Aux 1 Engine Fan
Aux 2 N/C
Aux 3 Tachometer
Aux 4 Boost Control Solenoid
Aux 5 Idle Step A
Aux 6 Idle Step B
Aux 7 Idle Step C
Aux 8 Idle Step D
Aux 9 Front Oxygen Sensor Heater
Aux 10 I/C Spray Lamp
Aux 11 N/C
Digital Inputs
DI 1 Road Speed
DI 2 Start Signal
DI 3 N/C
Dl 4 Air Con Request
DI 5 N/C
DI 6 Ignition Switch Input
DI 7 XS Connector
DI 8 XS Connector
DI 9 Power Steer Switch
DI 10 N/C
DI 11 Alternator G Terminal
DI 12 N/C
Analog Inputs
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An Temp 1
An Temp 2
An Temp 3
An Temp 4
An Volt 1
An Volt 2
An Volt 3
An Volt 4
An Volt 5
An Volt 6
Load 1
Load 2
Load 3
Ignition Channels
Ignition 1
Ignition 2
Ignition 3
Ignition 4
Ignition 5
Ignition 6
Ignition 7
Ignition 8
Injection Channels
Injection 1
Injection 2
Injection 3
Injection 4
Injection 5
Injection 6
Injection 7
Injection 8

Engine Temperature

Inlet Air Temperature

Fuel Temperature

XS Connector

XS Connector

Front Oxygen Sensor Signal
Rear Oxygen Sensor Signal (if fitted)
MAF Sensor Barometric Pressure
N/C

N/C

MAP

MAF

TPS

Cylinder 1/4 Igniter

Cylinder 2/3 Igniter

A/C Clutch

Catalytic Converter Temp. Light
MIVEC

N/C

N/C

N/C

Cylinder 1 Injector
Cylinder 2 Injector
Cylinder 3 Injector
Cylinder 4 Injector
Main Relay Control
N/C

Fuel Pump Relay
Fan Speed Relay
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EVO IV, EVO V, EVO VI
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Auxiliary Drivers
Aux 1
Aux 2
Aux 3
Aux 4
Aux 5
Aux 6
Aux 7
Aux 8
Aux 9
Aux 10
Aux 11

Digital Inputs
DI 1
DI 2
DI 3
Dl 4
DI 5
DI 6
DI7
DI 8
DI 9
DI 10
DI 11
DI 12

Analog Inputs
An Temp 1
An Temp 2
An Temp 3
An Temp 4
An Volt 1

Engine Fan (Low Speed)
Secondary Air Solenoid
Tachometer

Boost Control Solenoid
Idle Step A

Idle Step B

Idle Step C

Idle Step D

Front Oxygen Sensor Heater
I/C Spray Lamp

Engine Fan High Speed

Road Speed

Start Signal

N/C

Air Con Request
N/C

Ignition Switch Input
XS Connector

XS Connector
Power Steer Switch
N/C

Alternator G Terminal
Idle Switch

Engine Temperature
Inlet Air Temperature
Fuel Temperature
XS Connector

XS Connector
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An Volt 2 Front Oxygen Sensor Signal
An Volt 3 Rear Oxygen Sensor Signal (if fitted)
An Volt 4 MAF Sensor Barometric Pressure
An Volt 5 N/C
An Volt 6 N/C
Load 1 MAP
Load 2 MAF
Load 3 TPS
Ignition Channels
Ignition 1 Cylinder 1/4 Igniter
Ignition 2 Cylinder 2/3 Igniter
Ignition 3 A/C Clutch
Ignition 4 Catalytic Converter Temp. Light
Ignition 5 Fuel Pump Speed
Ignition 6 MAF Reset
Ignition 7 Condenser Fan Relay (Some models)
Ignition 8 I/C Spray Relay
Injection Channels
Injection 1 Cylinder 1 Injector
Injection 2 Cylinder 2 Injector
Injection 3 Cylinder 3 Injector
Injection 4 Cylinder 4 Injector
Injection 5 Main Relay Control
Injection 6 Secondary Air Control Solenoid
Injection 7 Fuel Pump Relay
Injection 8 Fuel Pressure Regulator Bipass
*** Immobilser vehicles swap Ignition 3 and
Injection 7 functions.
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EVO VII, EVO VIII

Auxiliary Drivers
Aux 1
Aux 2
Aux 3
Aux 4
Aux 5
Aux 6
Aux 7
Aux 8
Aux 9
Aux 10
Aux 11

Digital Inputs
DI 1
DI 2
DI 3
Dl 4
DI5
DI 6
DI 7
DI 8
DI 9
DI 10
DI 11
DI 12

Analog Inputs
An Temp 1
An Temp 2
An Temp 3

N/C

EGR

Tachometer

Boost Control Solenoid
Idle Step A

Idle Step B

Idle Step C

Idle Step D

Front Oxygen Sensor Heater

I/C spray Lamp
N/C

Road Speed

Start Signal

Fuel Tank Pressure

Air Con Request

I/C Spray Request (Manual)
Ignition Switch Input

XS Connector

XS Connector

Power Steer Switch

I/C Spray Request (Auto)
Alternator G Terminal
N/C

Engine Temperature
Inlet Air Temperature
Fuel Temperature
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An Temp 4
An Volt 1
An Volt 2
An Volt 3
An Volt 4
An Volt 5
An Volt 6
Load 1
Load 2
Load 3
Ignition Channels
Ignition 1
Ignition 2
Ignition 3
Ignition 4
Ignition 5
Ignition 6
Ignition 7
Ignition 8
Injection Channels
Injection 1
Injection 2
Injection 3
Injection 4
Injection 5
Injection 6
Injection 7
Injection 8

XS Connector

XS Connector

Front Oxygen Sensor Signal

Rear Oxygen Sensor Signal (if fitted)
MAF Sensor Barometric Pressure
N/C

N/C

MAP

MAF

TPS

Cylinder 1/4 Igniter

Cylinder 2/3 Igniter

A/C Clutch (See Known Issues)
Purge Solenoid

Fuel Pump Speed

MAF Reset

Condenser Fan Relay

I/C Spray Relay

Cylinder 1 Injector

Cylinder 2 Injector

Cylinder 3 Injector

Cylinder 4 Injector

Main Relay Control

Secondary Air Solenoid (EVO IV only)
Fuel Pump Relay (See Known Issues)
Fuel Pressure Regulator Bipass

*** Immobilser vehicles swap Ignition 3 and
Injection 7 functions.

EVOLink G3 Inst. Manual

© Link ElectroSystems Ltd 2006 Page 31




EVO IX

Auxiliary Drivers

Aux 1 Engine Fan

Aux 2 VVT Control Solenoid

Aux 3 Tachometer

Aux 4 Boost Control Solenoid

Aux 5 Idle Step A

Aux 6 Idle Step B

Aux 7 Idle Step C

Aux 8 Idle Step D

Aux 9 Fan Relay High (Some models only)

Aux 10 Oxygen Sensor Heater

Aux 11 Fuel Pressure Regulator Bipass Solenoid
Digital Inputs

DI 1 Road Speed

DI 2 VVT Cam Position

DI 3 A/C Switch (Temperature Dial)

Dl 4 Alternator FR Terminal

DI5 A/C Request Switch

DI 6 Ignition Switch Input

DI 7 I/C Manual Switch

DI 8 I/C Auto Switch

DI 9 Power Steer Switch

DI 10 Start Switch

DI 11 N/C

DI 12 N/C
Analog Inputs

An Temp 1 Engine Temperature

An Temp 2 Inlet Air Temp. (Plenum Temp)

An Temp 3 Inlet Air Temp. (AFM or external IAT)
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An Temp 4
An Volt 1
An Volt 2
An Volt 3
An Volt 4
An Volt 5
An Volt 6
Load 1
Load 2
Load 3
Ignition Channels
Ignition 1
Ignition 2
Ignition 3
Ignition 4
Ignition 5
Ignition 6
Ignition 7
Ignition 8
Injection Channels
Injection 1
Injection 2
Injection 3
Injection 4
Injection 5
Injection 6
Injection 7
Injection 8

N/C
Oxygen Sensor Signal

Barometer Voltage (from AFM)

N/C
N/C
N/C
N/C

AFM Signal or External MAP Signal
MAP (factory fitted sensor in plenum)

TPS

Cylinder 1/4 Igniter
Cylinder 2/3 Igniter

Fuel Pump

Condenser Fan Relay 2
Condenser Fan Relay 1
Secondary Air Solenoid
CE Lamp

Fuel Pump Speed Relay

Cylinder 1 Injector
Cylinder 2 Injector
Cylinder 3 Injector
Cylinder 4 Injector
I/C Spray Relay
I/C Spray Lamp
A/C Relay

Main Engine Relay
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